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Theoretical Part:
* Available material for the VR Project
* One interface to rule them all (VR Game Engine)
* Unity: Current VR engine in |IIG
* Interface (Unity Editor)
* Unity Elements
* Virtual Reality in Unity



Available material for the VR Project

e 3 Oculus Rifts

e 2 HTC Vives

e 1 Katwalk VR + 1 HTC Vive + 3 Vive Trackers
* 1 Hololens

* 1 GearVR + Samsung Galaxy S7

* Some Oculus Go

 Some Cardboards

* 6 Vive Trackers

* 2 Kinects V2

* 5 Leap Motions



Available material for the VR Project

* VR Headset B h D Tﬁt

Oculus Rift HTC Vive

e AR Headset P

Hololens

e Cardboard Headset

Cardboard GearVR + Samsung Galaxy S7

Oculus Go



Available material for the VR Project

* Tracking System

¢ -

Vive Tracker Kinect V2

Leap Motions

* Treadmill

Katwalk VR




Programming Assignment

* 1 programming assignment: a real-time physically-based application
with tracking done with Unity; this year the project is to be done
in groups of 3 (40%), during weeks 7-12, demo and project grading
on week 13.

* Select among projects given or propose a project

* Material only available in the lab: KatwalkVR, HTC Vive, Oculus,
Hololens

* The other material can be borrowed.
* Each device can be used by two groups.



One interface to rule them all (VR Game Engine)

* A system designed for development of VR scenes

* Provides a software framework that the users use to create
interactive scenes / implement game scenarios

* Typical VR engines include:
» 2D/3D graphics
* Physics engine (collision detection)
* Sound
* Scripting
* Animation
* Networking
* etc



One interface to rule them all (VR Game Engine)

* Open Source VR engine
* OpenGL @GL@
* Ogre3D
 Panda3D m
* OpenSceneGraph
e Godot Engine ‘¢ o

* Etc. “
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One interface to rule them all (VR Game Engine)

* VR engine with license Qunlty
* Unity3D
* Unreal Engine
* 3Dvia Studio (Virtools 5.1 last version)
* Cryengine UNREAL
* Worldviz ENGINE

* Amazon Lumberyard

* etc @

CRYENCINE' 3

3dvia @) studio WORLD'W'VIZ



One interface to rule them all (VR Game Engine)

* Comparison

_ Open-Source VR engine VR engine with license

GUI
(visual development)

Latest features availability
(e.g. Geometry Shader)

VR adaptation (e.g. HMD)
Development
Resources

Multi-platform
development

External device
integration

No

Fast

Libraries

Time consuming
Rich

Not limited

Not easy (via APIs)

Yes

Slow (Closed)

Plug-ins (API)
Time saving
Limited
Limited

Easy (via Plug-ins)



Unity: Current VR engine in |G

e Unity3D Q unity

* Interface (GUI)

* Powerful scripting

Multiple platforms supported

Features (animation, network sound, physics engine, etc...)
Support (forum)

Resources (asset store, demos, tutorial samples, etc...)

Not expensive and free for education/personal use



Unity: Current VR engine in |G

* Unity3D - GUI

& Uity - AngryBotsunity - AngryBots - PCand Mac Standalone NN - -—

File Edit Assets GameObject Component Terrain Tools Window Help

Enemi
Enviror

Env
Environme
Envir

Main Came

High

http://docs.unity3d.com/Documentation/Manual/UnityBasics.html

Prefab
1

Transform




Unity: Current VR engine in |G

@unity

* Intuitive tool
* Low cost development system
e 2D and 3D interactive content
Build-in physics engine
Multiplatform publishing
Quality control
Ready-made assets
Knowledge-sharing community




Interface (Unity Editor)

Toolbar syer v (T - > 11 p

- > Play/Pause/Step (Test your game
Hierarchy PrEm— FE— without compiling)
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| SR Several Tabs: Scene (Manipulate your objects)/Game (rendered on
LLghates clizol] ¥ (9l ma i szmes”.  your camera)/Asset Store (download Unity packages)




Unity Elements: Overview

* Assets

* Scenes

* Game Objects
* Components
* Scripts

* Prefabs

* Interface



Unity Elements: Overview

* 3D coordinate system

* Local space/World space

e Camera and view port

* Polygons, edges, vertices, and meshes
 Materials, textures, and shaders

* Rigid Body physics

e Collision detection



Unity Elements: GameObject

Name of the Object: Way to find it. Static: Non-moving object (Useful for rendering optimization)

Icon to highlight your | object in the scene.

/ Inspector: Access the GameObject properties.
© Inspectdr Services B =
\/

" o GameObject Static ¥
Tag | Untagged + | Layer | Default $
Vv .~ Transform \ =
Position X 0 Y 0 Z0 \
Rotation X 0 Y 0 Z0 N\
Scale X1 Y 1 Z1 AN

/ 1 N\

Tag: group membership (Useful for raycasting or finding a group of objects)| ~ Layer: Access to the GameObject properties.

|

Transform: 3D coordinates (Position, Rotation and scale) left-handed coordinate system.



Unity Elements: Components

'@ Inspector Services @
" ¥ GameObject Static ¥
Tag | Untagged +| Layer | Default $
¥ .~ Transform @ %
Position X|0 Y 0 Z0
Rotation X|0 Y 0 Z0
Scale X1 Y(1 Z|1
Add Component [
Q |
Component
T -
Effects >
Physics
Physics 2D
Navigation
Audio
Video
Rendering
Tilemap
Layout
Playables
AR
Miscellaneous -

Mesh: Vertex of your 3D object (3D shape)
Effects: Special renderer effect (particle effect)

Physics: Gravity (Rigidbody), Collision (Collider)
Navigation: Pathfinding Algorithm (Nav Mesh Agent)

Audio: Audio Listener (your avatar), Audio Source (3D
sound) and different Filters

Rendering: Camera and Skybox

Layout: Canvas (Menu in your game)

Miscellaneous: Terrain and Wind Zone.



Unity Elements: Main Camera

© Inspector

F @ Main Camera Tag: Main Camera (the default camera used
b by unity to render your game)

Background: The colour of the area when
there is no Skybox

Field of View: The more important it is, the
more you need to render.

Clipping Plane: The size of the area that
needs to be rendered.




Unity Elements: Directional Light

¥ [Directional Light
Tag

By default, Unity creates one directional light
but you can create several to make special
effects:

e Attach to an object

* Light some confined space

* Etc....




Unity Elements: 3D object

< Unity 2017.3.1f1 Personal (64bit) - Untitled - New Unity Project - PC, Mac & Linux Standalone* <DX11> - X
File Edit Assets GameObject Component Window Help
@ S| E K = Center | @ Local > 1l M & Collab ~ & | | Account  ~ Layers ~ | | Layout ~
= Hierarchy # Scene © Inspector
I Create 'l (arA ‘ Shaded 'I l 2D || g3 l'ﬂ» ] ad \'l Gizmos 'I (o ATl ) e  [Cube | [ static +
v € Untitled* = = -
ENE ‘_, Tag | Untagged 4| Layer [ Default dal
Mair Copy ¥ .~ Transform %,
Dire Paste Position X|3.199 Y 2.567 Z/3.567
Rotation X 50 Y -30 Z\0
Rename
Scale X1 Y1 Z|(1
Duplicate
P ¥ | Cube (Mesh Filter) *
Delete Mesh [ Cube o
Select Prefab v i ¥ Box Collider *,
Edit Collid
Create Empty Hiaer
. Is Trigger O
3D Obj > Cube
:pct Material ‘None (Physic Material) ‘e
2D Object 2 Sphere Center x[0 Yo 2o
Effects > Capsule Size x[1 Y[1 z[1
Light > Cylinder v . ¥Mesh Renderer @
Audio > Plane » Lighting
Video > Quad kil
Dynamic Occluded ¥4
ul > Ragdoll...
Camera Terrain Default-Material Q) %
Tree > Shader | Standard .
. Wind Zone
“@Project | [Console Add Component
3D Text

l Create 'l
¥ | /Favorites  Assets

(N an as_a_.2 1]




Unity Elements: Plane vs Terrain

* Plane : 3D object (Primitive) with a simple Collider (less computation)

* Terrain: 3D object with a terrain component with a specialized tool.
@ #

v w# ¥ Terrain

i - BEik3

Paint Trees
Click to paint trees,

Hold shift and click to erase trees.

Hold Ctrl and click to erase only trees of the selected type.

Trees

No trees defined

[ #* Edit Trees... ] [ Refresh ]

| Mass Place Trees |

» Lighting

v ¢ ¥ Terrain Collider Q) %=
Material None (Physic Material) (o]
Q

Terrain Data #New Terrain

Enable Tree Colliders v




Unity Elements: Scripting

* Inherit from Monobehaviour }'@@cubewfrivt)

Script
Cube Prefab

* Visual Studio Community C# | Geation

cube

None (Game Object)

None (Transform)

e Attach to a GameObject to change its behavior

* |nstanciate Prefab on runtime -

111

class Instantiatecube : MonoBehaviour {

ublic GameObject CubePrefab;
ublic Transform location;

oid Start () {

yid Update () {

Instantiate (CubePrefab,location);



Unity Elements: Prefab

“Prefab acts as a template from which you can create new object
instances in the scene.”*1

¥ Cube (1) 1 [] Static ¥

None (Physic Material)
0
il

*1 https://docs.unity3d.com/Manual/Prefabs.html



U N |ty E | eme ntS Au d |O 3D Sound = “all channels downmixed to mono and attenuated

according to distance and direction.”*1

Original Sound Clip

The sound can be output through an audio listener or
an audio mixer.

Change 2D sound to 3D Sound

Sound Effect to reverberate your sound (Cave like)

*1 https://docs.unity3d.com/Manual/class-AudioSource.html



Unity Elements: Audio

¥ [Main Camera ][] static ¥
Tag |MainCamera | layer Defawe i

All Mixers Master Tab to manage your different mixers

Snapshot

Manage the different mixers
under different subgroups Simple output without any effect

Add affect to a group of sound



Unity Elements: Audio

How loud the sound is at a distance of
Volume one world unit (one meter) from the

Audio Listener.*1 if (Input.GetKeyDown(KeyCode.Z) )

{
step.volume = Random.Range(0.8f, 1.0f);

step.pitch= Random.Range(0.8f, 1.0f);
step.PlayOneShot(step.clip);

Amount of change in pitch due to
Pitch slowdown/speed up of the Audio Clip.
Value 1 is normal playback speed.*1

}
else if (Input.GetKeyUp(KeyCode.Z))
{

step.Pause();
}

*1 https://docs.unity3d.com/Manual/class-AudioSource.html



Unity Elements: Mecanim

Add Key Frame to your animation The Animation Tab allows you to create simple animations directly in
N\ Unity

Move in your animation
Record your animation when moving your object Control your animation manually

Created on the GameObject you have animated




Unity Elements: Mecanim

This tab opens automatically when an animator is created. One animator can
control different animation clips thanks to the Animator tab.

H Scene

|Layers H Parameters | - - Auto Live Link

(ariame pES

Different variables to control
different states.

Transition and State (animation clip)



Unity Elements: Networking

Add this component to an Empty GameObject named

Registered Spawnable Prefabs:
List is Empty
+ -

NetworkManager

Test your application on one machine

Add the player prefab to be instantiated in the scene

Randomly spawn your player in the different location
implemented

HUD to control the Network Manager on runtime



Unity Elements: Networking

All these components need to be added on the player prefab

HUD to control the Network Manager on runtime

HUD to control the Network Manager on runtime

~ HUD to control the Network Manager on runtime



Virtual Reality in Unity

To have a good VR application you need :
* Good Interaction (Grabbing/Ul/Controller)
* Good Physics
e Good Al (Social/Behavior)
* Locomotion (Motion Sickness)




Virtual Reality in Unity

 Edit -> Project Settings -> Player -> XR Settings-> Virtual Reality Supported
-> The camera tagged Main Camera will move according to your head

It is not enough to have a VR application. It is just the beginning of your
journey.



Install the Last Unity Version for next course

e Link to download :

https://store.unity.com/fr/? ga=2.187361902.794958388.1519564968
-856357652.1519564968

Different use means different plans but one application:

 Personal License: Annual revenue or funds raised of S100k or less.
* Plus: Annual revenue or funds raised of $200k or less.

* Pro: No limits on revenue or funding.

=>Choose Personal License


https://store.unity.com/fr/?_ga=2.187361902.794958388.1519564968-856357652.1519564968

Questions?



Useful Resources

* Unity3D:
https://unity3d.com/fr/learn/tutorials

https://unity3d.com/fr/learn/tutorials/topics/asset-store/merry-
fragmas-multiplayer-fps-part-1

* VR:

https://assetstore.unity.com/packages/tools/vrtk-virtual-reality-toolkit-
vr-toolkit-64131

https://unity3d.com/fr/learn/tutorials/s/virtual-reality



https://unity3d.com/fr/learn/tutorials
https://assetstore.unity.com/packages/tools/vrtk-virtual-reality-toolkit-vr-toolkit-64131

Useful Resources

* Mecanim:

https://unity3d.com/fr/learn/tutorials/modules/intermediate/live-
training-archive/character-animation-setup?playlist=17099

https://unity3d.com/fr/learn/tutorials/topics/animation/animate-
anything-mecanim

* Networking:

https://unity3d.com/fr/learn/tutorials/topics/multiplayer-
networking/introduction-simple-multiplayer-example?playlist=29690


https://unity3d.com/fr/learn/tutorials/topics/animation/animate-anything-mecanim

